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Pivot Tables in Excel 



PivotTable Reports 101 for Excel 

Let's suppose you've compiled a large list of data — for example, sales figures for every product your company 
makes. But now you're ready to extract some meaningful information from the data. For example, you might 
want to answer the following questions:  

• What are the total sales for each product by region?  

• Which products are selling best over time?  

• Who is your highest-performing salesperson?  

For these and other questions, you can create a PivotTable© report — an interactive table that automatically 
extracts, organizes, and summarizes your data. You can then use the report to analyze the data — for example, 
make comparisons, detect patterns and relationships, and analyze trends.  

For example, you can use this source data ...  

 

... to create a PivotTable report that shows how each product is selling in each sales region.  

 

Read on to discover what you can do with a PivotTable report.  

Summarize and analyze your data  

To see the "big picture" of your data you can use a PivotTable report to summarize and analyze the data. You can 
control how Microsoft Excel 2002 summarizes the data — for example, by sum, average, or count — without 
entering a single formula.  

Add or remove data  

Not quite enough information in your PivotTable report? For example, maybe you want to include sales figures 
broken down by salesperson. You can easily add or remove categories of data.  

For example, add the Salesperson field:  



 

Quickly Rearrange the Layout  

Not satisfied with the layout of your PivotTable report? For example, maybe you'd prefer to display the 
salesperson information in rows instead of in columns. The interactive nature of your PivotTable report lets you 
literally turn the table: you can easily move (or "pivot") the rows and columns to view different summaries of the 
data.  

For example, you can move the Salesperson field so it appears down the rows instead of across the columns.  

 

View a subset of the data  

Want to filter the data so you can view a manageable chunk at a time? To do this, you can use a page field to 
break the PivotTable report into separate "pages." Each page contains a subset of the data that's summarized in 
the PivotTable report.  

For example, you can add a page field for the Year category. That way, you can view sales data for an individual 
year (such as 2003), or for all years combined.  

 

Are there other reasons to use page fields?   If your PivotTable report contains many fields, you can use 
page fields to keep your report compact and readable. Or, if you're retrieving data from some types of large 
external databases, you can add and then set up page fields so that they limit the amount of data retrieved at a 
time. That way, you can avoid long waits and memory problems.  

Show just the details you want  



Want to zero in on specific details in a PivotTable report? You can display or hide items in a row or column field — 
for example, specific products or salespeople. You can also display or hide details about items in row or column 
fields.  

For example, in the Type field, you can hide all product items except beverages:  

 

Step 1: Prepare the source data  

You're probably anxious to get started on your first PivotTable report. But before you begin, it's a good idea to 
make sure your data is well organized and ready to go.  

In this section, you'll learn what kinds of data you can use to create a PivotTable report, and what you need to do 
to prepare it. Once you've prepared the data you can create the PivotTable report by using the PivotTable and 
PivotChart Wizard. In the wizard, you'll actually choose the source data. (You can choose data already entered in 
Excel, or data from a database, called an "external data source.") If you've chosen an external source, the wizard 
lets you use a separate program called Microsoft Query to connect to the source and select just the data you 
want.  

Types of data you can use  

• Excel list or database  

• External data   For example, you can use a database file, text file, or a source on the Internet.  

• Multiple consolidation ranges   You can combine and summarize data from several different Excel 
lists.  

• Another PivotTable report   Do you plan to use the same data to create multiple PivotTable reports? 
If so, you can save memory and disk space by reusing an existing PivotTable report to create a new 
PivotTable report. This action  links both the original and new PivotTable reports. (For example, if you 
refresh the data in the original PivotTable report, the data in the new report is also refreshed, and vice 
versa.)  

What you need to do to prepare the data  

To prepare the data for a PivotTable report, just read the section below that corresponds to the type of data 
you're using.  

Prepare data from an Excel list or database  

There are a few things to consider in preparing your Excel data:  

• Make sure the list is well organized   Neatness counts! For example, make sure the first row of the 
list contains column labels, since Excel will use this data for the field names in the report. Also, make 
sure each column contains similar items — for example, include text in one column and numeric values 
in a separate column.  

• Remove any automatic subtotals   Don't worry — the PivotTable report will calculate the subtotals 
and grand totals for you.  

• If you plan to add more data later, name the range   Then, when you create the PivotTable report, 
make sure to specify the name when you enter the source data range. That way, whenever you add 
more data to the range, you can update the PivotTable report to include the new data.  

• If you want to use filtered data use the Advanced Filter command   On the Data menu, point to 
Filter, click Advanced Filter, and then click Copy to another location. This extracts the filtered data 



to another worksheet location, so you can use it in your PivotTable report. Don't filter the data in place 
or use the AutoFilter command. This hides some of the data but the PivotTable report will include all 
the data from the list.  

Prepare data from an external source  

There are a few things to consider in preparing your external data:  

• Install the necessary tools and drivers   You're probably all ready to go — just make sure you've 
installed Microsoft Query and the appropriate open database connectivity (ODBC) drivers or data source 
drivers you need. Then, when you create a PivotTable report with the PivotTable and PivotChart Wizard, 
you'll use Microsoft Query to actually retrieve the external data.  

• In the following cases, retrieve the data before starting the wizard   Check the following list — if 
it contains your data retrieval method, you won't be able to use Query from within the PivotTable and 
PivotChart Wizard to retrieve the data. Instead, use the following instructions to insert the data in an 
Excel workbook. You can then use the wizard to select the worksheet range that contains the external 
data just as you would any other Excel list.  

Office Data Connections   Office Data Connection, or .odc, files are the recommended method of 
retrieving external data for your reports. You can use them whenever you're simply retrieving data from 
a single database table or from an OLAP database, so that you don't need to combine data from more 
than one table in the external database or filter the data to select specific records before creating the 
report. 

Query files and report templates   To use a query file (.dqy, .oqy, or .rqy extension) to retrieve the 
data open the query file in Excel. To use a report template (.xlt) that doesn't already include a 
PivotTable report, open the template. 

Parameter queries   To use a parameter query to retrieve the data you must first create the 
parameter query in Microsoft Query so that it returns the data to Excel. Note that you can't create a 
parameter query to retrieve source data from OLAP databases. For information about creating 
parameter queries, see Help in Microsoft Query. 

Web queries   To use a Web query to retrieve data over the Internet, you must first create a Web 
query and retrieve the data into Excel. To create a Web query, point to Import External Data on the 
Data menu, and then click New Web Query. 

Prepare data in multiple ranges for consolidation  

There are a few things to consider in preparing data from multiple Excel lists:  

• Make sure the lists are well organized   Neatness counts! For example, make sure the lists have 
matching row and column names for items you want to summarize together.  

• Remove any automatic subtotals   Don't worry — the PivotTable report will calculate the subtotals 
and grand totals for you.  

• If you plan to add more data later, name the ranges   Then, when you create the PivotTable 
report, make sure to specify the names when you enter the source data ranges. That way, whenever 
you add more data to a range, you can update the PivotTable report to include the new data.  

Prepare data from another PivotTable report  

There are a few things to consider in preparing data from another PivotTable report:  

• Make sure both PivotTable reports are in the same workbook   If the original PivotTable report is 
in a different workbook, copy the original report to the workbook where you want the new report to 
appear.  

• Check the page field settings   In the original PivotTable report, you may have changed the page 
field settings so they retrieve external data for each page individually. In this case, you need to reset 
the page fields so they retrieve external data for all items at once. To check the settings, double-click 
each page field and then click Advanced. (If you aren't sure which fields are the page fields, see the 
illustration in section "Anatomy of a PivotTable report" in part 2 of this article.)  



Step 2: Create a PivotTable report  

To create a PivotTable report, you first use the PivotTable and PivotChart Wizard to specify the data you want to 
use and to create the report framework. You can then use the PivotTable toolbar to arrange the data within that 
framework.  

For example, you can choose the categories of data to include (shaded in blue) and the corresponding data 
values to summarize (shaded in yellow):  

 

Then, tell Excel how to arrange the data categories in the rows and columns of the PivotTable report. When Excel 
creates the finished report, it automatically summarizes and totals the data values.  

 

Start by using the PivotTable and PivotChart wizard  

1. Open the workbook where you want to create the PivotTable report. If you're basing the report on an 
Excel list or database, click a cell in the list or database.  

2. On the Data menu, click PivotTable and PivotChart Report.  
3. In step 1 of the PivotTable and PivotChart Wizard, follow the instructions, and click PivotTable under 

What kind of report do you want to create?  
4. Follow the instructions in step 2 of the wizard. If you're retrieving external data for the PivotTable 

report, you can get more information about using Microsoft Query or the Query Wizard from either Excel 
or Query Help.  

5. In step 3 of the wizard, click Finish.  

Lay out the PivotTable report  

1. From the PivotTable Field List window, drag field buttons to the labeled areas on the PivotTable 
diagram.  

2. If you want to rearrange the fields, drag them from one area to another. To remove a field, drag it 
outside the PivotTable report. 

In some cases, you might not want to lay out the PivotTable report directly on a worksheet. For 
example, if your source data is from a large external database, worksheet layout may be too time-
consuming. In this case, you can click Layout in step 3 of the PivotTable and PivotChart Wizard to lay 
out the PivotTable report. 

 



Anatomy of a PivotTable Report  

You may have noticed that Microsoft Excel uses specific terms to identify the parts of a PivotTable© report. If 
you're not familiar with these terms, read this section for a quick primer.  

 

  Page field 
  Data field 
  Column field 
  Item 
  Row fields 
  Data area 

• Row field   A field from the source data that you assign to a row orientation in a PivotTable report. For 
example, Region and Salesperson are row fields.  

• Column field   A field from the source data that you assign to a column orientation in a PivotTable 
report. For example, Type is a column field.  

• Page field   A field from the source data that you assign to a page (or filter) orientation in a PivotTable 
report. For example, Year is a page field. You can use the Year field to display summarized data for only 
2003, 2004, and so on.  

• Item   A subcategory of a row, column, or page field. For example, the Type field contains the following 
items: Beverages, Dairy, and Meat; the Salesperson field contains the following items: Buchanan, 
Davolio, Dodsworth, and Suyama.  

• Data field   A field from the source data that contains values to be summarized. For example, Sum of 
Sales is a data field.  

For most types of source data you can choose how to summarize data (for example, by sum, average, 
or count). A data field usually summarizes numbers, but it can also summarize text. For example, you 
can count the number of times a specific text entry (such as Yes or No) appears in a field. 

• Data area   The cells in a PivotTable report that contain summarized data. For example, the value in 
cell C5 summarizes Buchanan's beverage sales for the East region in 2003. In other words, it's a 
summary of the sales figures for every row in the source data that contains the items Buchanan, 
Beverage, East, and 2003.  

Step 3: Customize a PivotTable report  

You've now created a PivotTable report, but that's only the first step. Remember all the questions you had about 
your data? A PivotTable report is more than just a static summary; you can use it to interactively explore the 
data's significance. Zero in on the details or pull back for an overview. View sales by region or over time. You 
decide the type of customizations you want:  

• Add or remove data.  

• Quickly rearrange the layout.  



• View a subset of the data with page fields.  

• Show just the details you want.  

Add or remove data  

Do you want to view more or fewer categories of data in your PivotTable report? You can easily add or remove a 
field — including a row, column, or page field.  

To add a field, drag a field from the PivotTable Field List window to the appropriate area on the PivotTable 
report. To remove a field, drag a field outside the PivotTable report.  

Note   You can't directly edit the data in a PivotTable report. Instead, you need to edit the source data and then 
refresh the PivotTable report.  

Quickly rearrange the layout  

Do you want to reorganize the PivotTable report to get a different perspective on the data? You can quickly 
"pivot" the report by moving a field or reordering the items within a field.  

To move a field, drag the field to the appropriate area on the PivotTable report. To reorder items within a field, 
drag an item to a new location in the field.  

Use page fields to view a subset of the data  

Did you include a page field in your PivotTable report? If so, you now have a three-dimensional report that 
consists of multiple "pages." Each page contains a subset of the data that's summarized in the report.  

To view a different page, click the arrow next to the page field item, and then click an item in the list.  

 

Show just the details you want  

In a PivotTable report, you can drill down on the details or hide information for a "big picture" view.  

Show or hide items in a row or column   Click the arrow in a field, and then select or clear the check boxes 
you want. For example, in the Type field, you can hide all product items except Beverages.  



 

Show or hide specific details for an item   Click an item in a field, and then click the Show Detail or Hide 
Detail button on the PivotTable toolbar. If prompted, click the field with the detail you want to show.  

For example, for the Beverages item in the Type field, you can include more detail by displaying the sales per 
year.  

 

Display the underlying source data for a specific data cell   Just double-click a cell to see its details. For 
example, double-click the subtotal for Beverages in the East region to see the source data records used to 
calculate the cell.  

 



Step 4: Print a PivotTable report  

Do you plan to print your PivotTable report? If it's a multipage report, you can set print options to control the 
report's printed appearance:  

• To make it easier to follow the PivotTable report from one page to the next, you can automatically 
reprint labels at the top of each page.  

• To ensure that a logical chunk of the PivotTable report is printed on each page, you can insert automatic 
page breaks.  

For example, a page break might fall between items in the Month field:  

 

On the printed page, you can repeat the labels from rows 1 and 2, and also repeat the outer row field item Apr.  

 

The following procedures describe how to set print options for your PivotTable report. After you set the options, 
you can click Print Preview on the File menu to preview the printed report. When you're ready to print the 
report, click Print.  

Repeat row labels on each printed page  

1. Make sure the PivotTable report is the only report in the print area. (To do this, click the PivotTable 
report, click PivotTable on the PivotTable toolbar, point to Select, and then click Entire Table. On 
the File menu, point to Print Area, and then click Set Print Area.)  



2. On the File menu, click Page Setup, click the Sheet tab, and then make sure the Rows to repeat at 
top and Columns to repeat at left boxes are blank. Click OK.  

3. Click the PivotTable report.  
4. On the PivotTable toolbar, click PivotTable, and then click Table Options.  
5. Under Format options, select the Set print titles check box.  

Repeat outer row field items on each printed page  

1. Click the PivotTable report.  
2. On the PivotTable toolbar, click PivotTable, and then click Table Options.  
3. Under Format options, select the Repeat item labels on each printed page check box.  

Print sections of a PivotTable report on separate pages  

1. Double-click the outer row field that has the items you want to print on separate pages.For example, if 
you want to automatically insert a page break between each type of product, double-click the Type row 
field.  

2. Click Layout.  
3. Under Print Option, select the Insert page break after each item check box, and then click OK 

twice.  
4. On the View menu, click Page Break Preview, and make any adjustments you want to the automatic 

page breaks. You can move a page break by dragging it, or delete a page break by pressing the DELETE 
key.  

More information  

Want to make your printed PivotTable report easier to scan? You use the Format Report button on the 
PivotTable toolbar can quickly switch to an indented format, in which the data for each row field is indented 
(similar to a text outline). Also, all the summary figures for a data field are displayed in a single column.  

 

 


